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ABSTRACT 

This technical report is adapted from the post mortems that I 
carried out after the preparation of the DAFx-01 and the NIME-
02 conference proceedings, together with notes and emails from 
various meetings and people who assisted me in the production 
of the various proceedings. 

Its purpose is to offer future conference organisers and 
proceedings editors the benefit of experience and of lessons 
learned in the skill of creating conference proceedings. 
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proceedings production, proceedings compilation 

 INTRODUCTION 

Initial I accepted the job of proceedings editor because I wished 
to develop my skills in editing and I wanted to learn some 
things along the way. One thing that I discovered early in my 
research was the absence of documentation or advice on how to 
begin the task of creating a proceeding for a conference. It was 
only after creating my first proceedings that I came across 
Malkinson’s overview of editing a proceedings [1]. Malkinson’s 
article focuses on a process view involved in being a 
proceedings editor while in this work a more “hands-on” focus 
is taken which is intended to compliment Malkinson’s 
overview. 

A proceedings is not a difficult document to create but it 
can be very time consuming for a neophyte editor. Narrowing 
our focus to providing the lessons necessary for a neophyte 
editor to relatively quickly and painlessly create a proceedings, 
we will give an overview of the common file formats 
encountered, point out what tools are required and what is their 
function in the editing of a proceedings, then how a proceedings 
can be created in specific. Finally we outline the use of 
templates as a necessary extension to the production of high 
quality conference proceedings. 

 FILE FORMATS 

 Definition 

In this paper, we assume the term file format to refer to 
document file format. The scope of the file formats which we 
deal with are limited by conference in the case of the DAFx and 
NIME conferences these formats were the MS Word document 
format and the LaTEX format. Postscript files were also used by 
a small number of authors but these were converted to PDF files 

and modified in this format if necessary. The PDF file format is 
the final format used for the production of the proceedings with 
the other file formats only used for editing prior to conversion 
to PDF or as templates. In the following paragraphs, we discuss 
the important aspects of the different file formats with regard to 
how they are used in the creation of conference proceedings. 
The only advice I will give on the use of file formats is to use 
the one that you are most familiar with. However in your role as 
editor you must be able to work with all the formats mentioned. 
The tools necessary to work with these formats are discussed in 
the next section.   

 MS Word Document 

Full Name: Microsoft Document File Format 
File Type: .doc 
Originator:  Microsoft Corporation, Inc. 
 

MS Word is the word editor for the Microsoft Office and 
uses the MS Word Document as its default file format. It is one 
of the most common document formats encountered due to the 
bundling of MS Word with the Microsoft Windows operating 
systems as the systems default editor. This is the dominant file 
format encountered when dealing with submissions sent from 
writers. There are several tutorials available on the Internet 
giving an introduction into the use of MS Word. 

 LaTEX 

Full Name: LaTEX: A Document Preparation System 
File Type: .tex 
Originator:  Donald E. Knuth. 
 

LaTEX is a system for typesetting documents, which has 
found a niche in the academic and scientific communities. Its 
foundation is based on Donald Knuth’s TeX typesetting system. 
The LaTEX is a macro extension to the TeX system. LaTEX is 
commonly used on Linux or Unix systems. It differs from MS 
Word in that it uses logical design over visual design. Logical 
design is where you explicitly state where and how to format a 
piece of text as well as what kind of type of text it is. Visual 
design is best seen in MS Word editors and related editors that 
use the “WYSIWYG” (what you see is what you get) paradigm. 
There are advantages and disadvantages of both types of design 
this has spurred much debate between proponents of the designs 
which is beyond the scope of this paper. An introduction into 
the LaTEX system can be found in Lamport [2]. 
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 PDF 

Full Name: Portable Document Format 
File Type: .pdf 
Originator:  Adobe Corporation, Inc. 
 

The Portable Document Format or PDF was designed to be 
a cross platform document format while retaining the same 
layout and formatting regardless of the platform or system being 
used. It another common document format encountered due to 
the bundling of Adobe’s Reader [3] with many operating 
systems. An important point to illustrate is that Adobe’s Reader 
will only read PDF files it will not modify them. Modifying 
PDF files requires specific tools such as Adobe’s Acrobat [3]. 
As well as Adobe tools there are several other free to use tools; 
all of these may be downloaded from the Internet. The “Tools” 
section of this paper discusses several of these.  

 CREATING CONFERENCE PROCEEDINGS 

The appropriate use of the correct Tools allow the easy creation 
of the proceedings, it’s further editing, indexing and the 
possible touch up of submissions. Management systems can 
assist in reducing administrative burdens and reduce time 
demands on the editor. The tools discussed in the following 
section for the most part are relatively platform independent but 
it has been my experience that access to both a Microsoft 
Window system and a Linux system can considerably easy any 
problems. The proceedings editing section is a practical 
description of the technique I have used to create various 
proceeding. 
 

 Submission Management 

The first item of concern to the neophyte editor is the various 
submissions. Submission management may or may not be part 
of their remit. In the case that they must also manage the 
submissions, software such as CyberChair [4] or BSCW [5] 
can be used to considerable ease the situation. CyberChair is a 
collaborative-shared workspace with specific focus on the 
management, collect and review of conference papers. BSCW is 
a more generalized collaborative-shared workspace both result 
from research projects in the area of CSCW. Having used both 
systems, I would highly recommend CyberChair for 
conferences but on general projects BSCW is peerless and can 
be used as a substitute for CyberChair with a little more work. 
The use of a submission management tool can help greatly in 
reducing the burden on your time and also simplify many 
administrational burdens. 

 Tools 

A couple of tools are required for editing the various file 
formats. Generally when creating templates for a conference the 
major formats used by the conference community are used. As 
discussed previously the two formats commonly used in the 
DAFx and NIME communities are MS Word and LaTEX. I 
have found that creating the proceedings can be most easily 
achieved using a Windows system using Adobe’s Acrobat and 
Distiller [3], MS Word [6] and WinEdt [7]. Certain occasions 
have required the use of an image editor such as Adobe’s 
Photoshop [3] but there are many other editors such as 
Paintshop Pro, which can easily achieve the same task. 
Proceedings may also entail the creation of a CD. The relevant 

web pages can be created using any website creation tool such 
as Macromedia Dreamweaver [8] or Microsoft FrontPage [6] 
but it is important to reuse the look and graphical design of the 
conference’s homepage if any. 

There is another category of tools sometimes required. 
These are archival tools such as Winzip, Winrar, Tar, Gzip and 
Stuffit to list a few of the notable archival formats. Many of the 
document submissions will be large and as such the writers may 
choose to compress these using an archival tool. An editor must 
have the full array of these tools available, fortunately these are 
available in either freeware/open-source or shareware versions. 
The three formats generally encountered are the Zip format, the 
Tar format and the Stuffit Format. Winzip or Gzip is used for 
the Zip format while Tar archives can be opened using the “tar” 
command on Linux machines or by Winzip on Windows 
machines. The Stuffit format is opened by Stuffit Expanded and 
is the archival format common to Macintosh machines.  

 

 Proceedings Editing 

The final versions of the submissions should be downloaded 
/ assembled on the editors system which has the relevant tools 
installed. Beginning the compilation of the proceedings all the 
submissions should be converted to the PDF file format. In the 
case of MS Word documents, you must install the full version 
of Adobe Acrobat which links an Adobe icon to your MS Word 
program as shown in Figure 1. Selecting or “double clicking” 
this icon will create a PDF file of the current MS Word 
document. 
 

 
Figure 1: Adobe Icon in MS Word 

 
In the case of LaTEX documents, conversion is simple on a 

Linux system using the LaTEX / TEX commands [2]. On a 
Windows system I recommend the use of the WinEdt software. 
WinEdt is a word processing package for using LaTEX and 
TEX in the Windows environment. The use of Miktex [9] and 
Ghostview [10], two open source projects supplement WinEdt 
and allow for the creation of PDF files from LaTEX or TEX. 
WinEdt is also useful in editing style files used in LaTEX / 
TEX templates for your conference. At this stage all the 
submissions should be have been converted into PDF files. 

The next step is to create a working directory for your new 
proceedings and copy the PDF submission files into it. 
Conference proceedings are generally laid out according to 
chronologically order, in that the first paper in the first session 
is at the start and followed by the other submissions, as they 
would occur during the conference. At this stage the editor 
should either using the web or contacting the local chair for the 
conference directly obtain a timetable for the conference. The 
timetable will serve as the ordering of the submissions within in 
the proceedings, so at this stage I normally rename the 
submissions into a numeric format representing when they are 
presented so the first paper to be presented is renamed to 
“01.pdf”, the twenty-third paper to be presented is renamed to 
“23.pdf” and so on. This leads into the creation of the body of 
the proceedings. 

The body of the proceedings starts with opening the file 
“01.pdf” and the user selects the command “Document -> Insert 
Pages” as shown in Figure 2. This is the first of three steps in 
adding a submission to the body. The next step involves 
choosing the next submission, which in this case will be the 
second submission as shown in Figure 3. The third step involves 
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adding this file to the end of the exist body as shown in Figure 
4. This is repeated for all the submissions until the body of the 
proceedings is completed. After this stage a new file should be 
saved using the “Save As” function, this file represents the 
proceeding’s body. 

 

 
Figure 2: Select Insert Pages 

 

 
Figure 3: Selecting the particular submission 

 

 
Figure 4: Determining where to add the submission 

 
The body of the proceedings has now been assembled at this 

stage, one of the first cleanup tasks is required. This is the 
renumber of the pages numbers within the document. The 
easiest way to achieve this is using the Text Touchup tool in 
Acrobat shown in Figure 5. Unfortunately it may not always be 
that easy, as submissions don’t always use the conference 
templates so the Text Addition tool may be needed to add the 
required text shown in Figure 6. The required text is normally a 
header with the conference name, date and location. A page 
footer is also required and usually consists of the conference 
acronym followed by a two-digit year and a page number. Both 
of these tools are displayed as glyphs on the left hand side menu 

in Acrobat. A helpful trick when adding text is to use the forms 
grid (“View -> Show Forms Grid”) as this can allow you to 
compare positioning of the header/footer text in the document. 
At this stage you will have a correctly numbered document with 
the necessary headers and footers. Now to put the finishing 
touches on a proceeding requires a few more sections. 
 

 
Figure 5: Text Touchup 

Tool 

 
Figure 6: Text Addition 

Tool 
 

These sections consist of the Cover page, the ISBN and 
Committee page, the Contents page/s, the Index page/s with the 
possible addition of one or more prefaces by various people and 
if available keynote addresses. It is these aspects that can really 
give the “Professional” touch to your proceedings. All of these 
pages are available online at [11] as templates for your own 
conference proceedings. 

The Cover page consists of the title of the conference, the 
word “Proceedings”, the place and date of the conference, your 
name as proceedings editor with anybody else that assisted in 
the production aspects and the organisations which organised 
the conference as well as any organisations or companies which 
sponsored the conference. This is shown in the Cover page 
template. 

The ISBN and Committee page consists of which 
organisation published the proceedings, the proceedings ISBN 
number, where and who additional copies may be ordered from, 
the homepage of the conference and possible previous 
conferences. The Committee section of the page consists of 
three elements. The Scientific / Review committee members 
and their affiliations, the Conference Organising committee 
members their affiliations and roles and the Conference Support 
and Coordination personnel and their affiliations and roles. The 
ISBN number should be order via your University library or if 
this is not an available resource your National Library and 
should be ordered early as the title of your proceedings is 
known well in advance. 

The Contents page is very similar to the conference 
timetable and relates to the page numbers within the body of the 
proceedings. At this stage you need to get a list of the 
submission titles, their authors and their page number within the 
submission. I normally include keynote texts in a keynote 
section after the main body of the proceedings and this is also 
listed in the Contents page. The Contents page is illustrated in 
greater detail in the Contents page template. 

The Index page is a very simple alphabetical layout of 
author surname, author first name initial and page number. It is 
included at the end of the proceedings to allow for quick 
reference to a particular author’s work. 

The last two sections of a proceeding’s are the prefaces and 
the keynotes. The prefaces are normally introductions to the 
conference by the chair/s of the conference and / or the body 
representing the area. These prefaces introduce the area, a look 
towards its future and a note about the current conference and 
future conferences. The keynotes are talks given by prestigious 
speakers knowledgeable in the conference’s domain. Both 
prefaces and keynotes also pose research questions about the 
conference’s domain, simulating areas of new research within 
the domain. A practice, which I have adopted, is to add the 
keynotes after the submissions and with page numbers to 
indicate which keynote speech it belongs to. This stems from 
the fact that keynotes are not submissions per se and do not go 
through the same review process as submission so they are 
more correctly categorized in a separate section. The keynote 
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layout may or may not use the submission template format but 
this is a matter of personal preference rather than convention. 

After creating these various pages, they need to be 
assembled into the proceedings. The Cover page, the ISBN and 
Committee page, any prefaces, the Contents page/s are 
assembled into one document which will comprise the front 
section of the proceedings. The back section of the proceedings 
consists of any keynotes and the Index page/s. These pages use 
a different numbering scheme to the rest of the proceedings 
excluding the keynotes as discussed previously. The format of 
the front section is to use page number in Roman Numerical 
form and in lowercase from the ISBN page to the last page 
before the body of the proceedings. In MS Word this can be 
selected by choosing the menu “Insert -> Page Numbers” as 
shown in Figure 7 and then by selecting the format option 
which shown in Figure 8 which displays the formatting choices 
shown in Figure 9 with the Roman Numerical in lowercase 
highlighted. The formatting process for the back section is very 
similar except that the page numbering is started from the last 
page number in the front section. At this point these sections are 
normally converted to PDF files and any additional blank pages 
necessary are added. Blank pages may be necessary to ensure 
the various sections start with their first page on the right hand 
side of the proceedings, in other words facing out. This is 
another style tip that can enhance the presentation and 
readability of your proceedings. 
 

 
Figure 7: MS Word “Insert -> Page Numbers” option 

 

 
Figure 8: MS Word “Page Numbers -> Format” option 

 

 
Figure 9: MS Word “Page Number Format” option 

 

The front and back sections are now ready to be added to 
the body of the conference proceedings. This method is the 
same as adding submissions to the body as shown in Figures 2 –
4. After this stage its time to enter the “Processing” stage as 
described in detail by Malkinson[1]. He breaks the “Processing” 
into four parts: 

a. Integrity Edit 
b. Format Edit 
c. Language Edit 
d. Substantive Edit 

 
The Integrity Edit main function is to “find global problems 

at an early stage and ensure all part of the publication match”. 
Examining paragraphs, sentences, lines, figures, tables, 
document structure and completeness of a document are typical 
activities in this area. The Format Edit is aimed at ensuring that 
“the chapters of the proceedings look and read like parts of a 
whole”. Activities include consistency checking of 
headers/footers, fonts, bullet lists, indentation, capitalization 
and references to figures, tables and actual references. The 
Language Edit is “concerned with how the writer expresses 
thoughts through language, regardless of format”. It “evaluates 
how clearly and precisely the sentences express explanations” 
and examines flow within the document. Checking spelling, 
grammar, punctuation and reconstruction of sentence fragments 
are among the various tasks carried out within this operation. 
The final stage or Substantive Edit is concerned with taking “a 
step back” and looking at the proceedings to ensure that it has a 
foundation and is fully completed. Checking that items such as 
legal notices, copyrights are included as well as checking 
organization and accuracy of the index and the table of contents 
are activities within this stage. After this it is essentially a 
matter of ensuring that the printers receive the proceedings 
either in a camera-ready format or in an electronic format, it is 
best to always include a completed hard copy. It is at this point 
where the work stops for many conference proceedings but 
increasingly conferences demand the production of a CD and / 
or website with finished proceedings. 

 Proceedings CD’s and web pages 

Similar work on creating multimedia conference 
proceedings has been discussed by Cheyney et al [12]; the work 
in for the DAFx and NIME conferences was aimed at producing 
both a printed and a CD version of the proceedings with the 
minimum amount of effort. The CD version is not aimed at 
being a fully interactive multimedia presentation as in 
Cheyney’s work; rather the end result will be a professional 
proceeding, which could be produced by a single editor. This 
type of CD is common in the small research communities such 
as the DAFx or NIME communities, whereas an interactive 
multimedia CD may be appropriate for larger research 
communities. It is important to evaluate the requirements for 
your community to ensure the correct type of CD is created. 

Lessening CD costs and the Internet has spurred the 
production of both a proceeding’s CD and also a proceeding’s 
website. The website is generally added to the conference 
website after the conference has finished but this depends on 
copyright issues. In order to “kill two birds with one stone” I 
generally create the CD with several web pages which can later 
serve the purpose as a proceeding’s section on the conference 
website. The layout which is I use is that of a Home page, a 
Table of Contents page, a Author Index page, a Search page and 
a Help page. Template versions of these pages taken from the 
NIME 2002 conference can be found online [11]. These pages 
can be edited to reflect your particular conference and its 
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submissions. It is important to retain the graphical design, 
layout, logo, etc from the conference website if any when 
designing your web pages. This ensures a graphical continuity 
between your pages and the actual conference website. This 
type of ascetics requires little editing and enhances the 
“Professional” look of your work. 

The Search page requires a little more work, as an index 
must be created for the papers. This requires the use of Adobe’s 
Catalogue bundled with the full version of Adobe Acrobat. The 
easiest manner of creating the index is to ensure all the papers 
are in a folder called “papers” and then edit the file 
“cd\navig\proc_idx.pdx” with Catalogue as shown in Figure 10 
replacing the Index title and descriptions and include directory 
to reflect your conference and its submissions. The Search page 
itself is normally presented as a PDF page with the MS Word 
template only used for its production but not included on the 
CD or website version. The search button on the Search page 
can be edited using the “Form tool” in Acrobat, which is shown 
in Figure 11 and found on the left hand side menu of Acrobat. 

 

 
Figure 10: Adobe Catalogue “Edit Index Definition” 

 

 
Figure 11: Adobe Acrobat “Form Tool” 

 
The proceeding’s CD / web pages should now be ready to 

be packaged. This stage involves copying the layout, structure 
and files to a separate computer or web server and ensuring that 
the hyperlinks function. It is vital discover that your web pages 
do not use absolute paths such as “C:\absolute\path” to 
resources on your computer but rather use relative paths 
“..\relative\path”. As important is ensuring that all graphic files 
as well as submissions are included and hyper linked correctly. 
CD duplicators or commercial CD printers will take the 
information in many media formats but I’ve learnt that if you 
send them a CD to duplicate ensure that the CD is “closed” or 
“finalized” when using your CD creation program. As with all 
things it is best to shop around for several quotations both for 
the printed proceedings and the CD production. A proceeding’s 
CD can have anything from a colour insert with colour 
embossing of the CD to a single colour embossing of the CD 
depending on your budget. 

 TEMPLATES 

These are part of the broad area of “Author Instructions” which 
includes layout, size limits, deadlines, file formats, graphical 
formats, document style, reference layout and style. It is one 
area that may or may not fall under the remit of proceedings 
editor. The templates for any conference are created prior to the 
first call for papers with the hyperlink to them included either in 

the call or prominently on the conference home page. The 
available of the templates is important for submissions. When 
submissions do not follow the conference layout and style they 
can require considerable time to reedit. The DAFx and NIME 
templates are available online [11] but use different layouts. 
The DAFx conference template uses a layout similar to ICASSP 
conference templates whereas the NIME template uses a layout 
similar to the ACM CHI conference templates. Many other 
styles and layouts exist varying elements from the numbers of 
columns per page to the reference style if there isn’t a decided 
format for the template it should be the first issue that is dealt 
with by the editor in conjunction with the conference 
committee. 

 CONCLUSIONS 

The editing of a proceeding is invisible and will go unnoticed 
by conference participants. Malkinson sums it up succinctly in 
that “the only people who should be able to tell that a 
proceedings was edited are its authors, its editor and other 
editors”. A good editor is a vital cog in the workings of a 
conference without which the quality of the conference will be 
directly affecteds. The creation of a conference proceeding can 
seem to be an overwhelming task but the burden can be reduced 
substantially using the appropriate tools and techniques. The 
practical approach taken by this article is aimed at ensuring that 
those new to editing of a conference proceeding use the tools, 
tricks and techniques discussed to produce a professional 
proceedings whether they be a print proceedings or a 
proceedings CD. 
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